“*Ef’-‘ VO SKOI T'-..--, OP Vzdélavini w

._-._.-.u_,_a EL CHOWY aro konkurenceschopnost
INVESTICE DO ROZVOJE VZDELAVANI

EVROPSKA UNIE i’

Vysoka Skola banska — Technicka univerzita Ostrava

Fakulta strojni

T

MATEMATICKE SIMULACE OBJEMOVEHO
TVARENI V PROGRAMU
SIMUFACT.FORMING 9.0

Studijni opora

Jan Kedron

Ostrava 2010

(ESF) arozpottu Ceské republiky vramci feSeni projektu OP VK

m Tyto studijni materialy vznikly za finan¢ni podpory Evropského socidlniho fondu
3 CZ.1.07/2.3.00/09.0147 ,,Vzdélavani lidskych zdroji pro rozvoj tyma ve vyvoji

a vyzkumu®.



Nézev: Matematické simulace objemového tvareni v programu Simufact.forming 9.0

Autor: Jan Kedroil
Vydani: prvni, 2010
Pocet stran: 64

Néklad: 5

Studijni materialy pro studijni obor 2303R002 Strojirenské technologie Fakulty strojni

Jazykova korektura: nebyla provedena.

~ L
* ¥ x |
* * le v
* * Ae
* * 1
* W .

&1 c D‘P \lldﬁtv:nl
EVROPSKA UNIE il L : ; /1 pro komkurenceschopnost

INVESTICE DO ROZVOJE VZDELAVANI

Tyto studijni materidly vznikly za finan¢ni podpory Evropského sociilniho fondu
a rozpo¢tu Ceské republiky v ramci FeSeni projektu Operaéniho programu Vzdélavani

pro konkurenceschopnost.

m Nazev: Vzdélavani lidskych zdroji pro rozvoj tymi ve vyvoji a vyzkumu
3 ; Cislo: CZ.1.07/2.3.00/09.0147

& Realizace: Vysoka skola banska — Technické univerzita Ostrava

© Jan Kedron

© Vysoka Skola banska — Technickd univerzita Ostrava

ISBN 978-80-248-2720-9



POKYNY KE STUDIU

Matematické simulace objemového tvareni v programu Simufact.forming
9.0

Pro studium problematiky Objemového tvareni jste obdrzeli studijni balik obsahujici:

. pfistup do e-learningového portalu obsahujici dopliikové animace vybranych ¢asti
kapitol
Prerekvizity

Pro studium této opory se predpoklada znalost na Urovni absolventa predmétu
Technologie tvafeni a slévani.

Cilem ucebni opory

Cilem je seznameni se zakladnimi pojmy objemového tvareni. Po prostudovani
modulu by mél student byt schopen nadefinovat podminky simulace pro objemové a plosné
tvateni v programu Simufact.forming 9.0.

Pro koho je predmét urcen

Modul je zatfazen do bakalafského studia oboru 2303R002 Strojirenskd technologie
studijniho programu B2341 Strojirenstvi, ale mize jej studovat i zdjemce z kteréhokoliv
jiného oboru, pokud spliiuje poZzadované prerekvizity.

Skriptum se déli na ¢asti, kapitoly, které odpovidaji logickému déleni studované latky,
ale nejsou stejné obsahlé. Predpokladana doba ke studiu kapitoly se miize vyrazné lisit, proto
jsou velké kapitoly déleny dale na ¢islované podkapitoly a t€ém odpovida nize popsana
struktura.
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Pri studiu kazdé kapitoly doporucujeme nasledujici postup:

Cas ke studiu: xx hodin

Na tvod kapitoly je uveden &as potiebny k prostudovani latky. Cas je orientaéni
a muze vam slouzit jako hrubé voditko pro rozvrzeni studia celé¢ho predmétu ¢i kapitoly.
Nékomu se ¢as muze zdat priliS dlouhy, nékomu naopak. Jsou studenti, ktefi se s touto
problematikou jesté nikdy nesetkali a naopak takovi, ktefi jiz v tomto oboru maji bohaté
zkuSenosti.

[@] Cil: Po prostudovani tohoto odstavce budete umét
4+ Popsat ...
4+ Definovat ...
& Vyfesit ...

Ihned potom jsou uvedeny cile, kterych mate dosahnout po prostudovani této kapitoly
— konkrétni dovednosti, znalosti.

G vise

Nasleduje vlastni vyklad studované latky, zavedeni novych pojmu, jejich vysvétleni,
v$e doprovazeno obrazky, tabulkami, feSenymi ptiklady, odkazy na animace.

O Shrnuti pojmu

Na zavér kapitoly jsou zopakovany hlavni pojmy, které si v ni mate osvojit. Pokud
neékterému z nich jesté nerozumite, vrat'te se k nim jesté jednou.

E Otazky

Pro ovéfeni, ze jste dobfe a Upln€ latku kapitoly zvladli, mate k dispozici nekolik
teoretickych otazek.

ZQ: Ulohy k FeSeni

Protoze vétSina teoretickych pojmii tohoto pfedmétu ma bezprostiedni vyznam
a vyuziti v praxi, jsou Vam nakonec pfedkladany i praktické ulohy k feSeni. V nich je hlavnim
vyznamem piedmétu schopnost aplikovat Cerstvé nabyté znalosti pro feSeni redlnych situaci.

. Kli¢ K reSeni

Vysledky zadanych ptikladi 1 teoretickych otdzek jsou uvedeny v zavéru ucebnice
v Klici k feSeni. Pouzivejte je az po vlastnim vyfeSeni uloh, jen tak si samokontrolou ovéfite,
ze jste obsah kapitoly skutecné Gplné zvladli.
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Uspésné a prijemné studium s timto ucebnim textem Vam preje autor.

Jan Kedron
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Pravodce studiem

Divody pro vyuzivani pocita¢ové simulace

Simulaci Ize fesit 1 velmi slozité technologické operace, které jsou neieSitelné nebo
obtizné fesitelné analytickymi metodami, popt. kde by pouziti analytického feseni bylo pfili§
zjednodusujici. Pomoci simulace je rovnéZ mozné provétit vysledky docilené jinymi
metodami z hlediska experimentli nebo vysledkl z praxe.

Simulace umoziuje studium chovani tvafeného materialu v redlném, zrychleném nebo
zpomaleném cCase. Po zhotoveni geometrického modelu a provedeni simula¢niho vypoctu lze
pak béhem nékolika minut nasimulovat priabéh celé¢ technologické operace. Jiz samotné
zkuSenosti z tvorby simulaéniho modelu mohou vést k navrhiim na zlepSeni geometrie ¢i
materidlu. Vytvofeni simulaéniho modelu totiz neni mozné bez dikladné analyzy
zkoumaného problému, kterd mtize odhalit v samém zacatku zpracovani zadani znacné
rezervy.

Simulace nabizi komplexni pohled na studovany problém a umoziuje tak jeho analyzu
na zaklad¢ vice kritérii. Zménou jednoho konstrukéné - technologického parametru lze
sledovat jeho vliv jak na chovani tvafeného materialu, tak na pribéh technologické operace
tvafeni 1 na pripadné vady produktu. Pomoci simulace je mozné dikladné provéfit rizné
varianty feSeni. To umoziuje minimalizovat rizika chybnych rozhodnuti.

Predstaveni firmy Simufact

EC Engineering nabizi produkty svétového lidra v oblasti simulacnich feSeni — firmy
Simufact (n¢kdejsi Femutec).

Simufact.forming je program, ktery vyvinula firma Simufact slou¢enim programi
MSC.SuperForge a MSC.Super.Form — slouzicich pro simulaci tvaiecich procesu.

Simufact je zaméteny na pozadavky primyslu svazaného s tvarecimi procesy. Vyvoj
programu byl zadan skupiné specialistil, kteti pracuji v oboru objemového tvateni.

Program dovoluje simulaci v§ech procesu tvaieni, napf.:

e Zapustkové a volné kovani (za studena 1 za tepla),
e Vilcovani,

e Protlacovani,

e Ohybani,

e Stithani,

e Chlazeni,

e Vytlaovani,

e Analyza néastrojt.

Fakulta strojni, VSB-TU Ostrava



Diky pouziti nové, v této oblasti vypoct, metody koneéného objemu, byl zkracen cas
vypoctl asi desetkrat ve srovndni se stejnou analyzou, kterd vyuzivd metodu konecnych
prvka. Obé dvé vypoctové metody jsou dostupné v Simufact.forming 9.0.

Simufact.forming 9.0 dovoluje jednoduché a rychlé definovani elementd a parametrii
procesu, jako jsou:

e stroje,
- buchary,
- hydraulické lisy,
- klikové lisy,
- vystfednikové lisy,
- ajiné,
e parametry tfeni,
e parametry vymeny tepla,
e parametry pfestavby sité (remeshing),
e razniky, pfitlaky,
e materidlové parametry,
e amnoho dalSich.

Do programu bylo zaimplementovano mnoho feSeni dovolujicich napf. automatické
sledovani zalozek, sledovani toku materidlu, simulace odpruzeni nebo analyzu naradi.

Simufact.material

Dodate¢na zakladna nabizi rozSifené materialové parametry nezbytné pii simulacich
ptipadt svazanych s pfedpovédi velikosti zrna nebo fazového rozkladu v hotovém vyrobku.

Simufact.project

Veliké mnozstvi udaji vyprodukovanych prostiednictvim simulaéniho procesu
vyZzaduje archivacni nastroj, ktery by byl dostatecné vypovidajici a ptfehledny. Pomoci
Simufact.projectu mizou byt idaje lehce organizovany, administrovany a ukladany.

Vyhody vyplyvajici ze zavedeni Simufact.forming 9.0:

e redukce nakladi pomoci rychlejsiho a efektivnéjSiho procesu zavedeni nové
technologie,

e zvétSeni stability procesd,

e virtudlni pfezkouSeni spravného tvaru nastroji a parametrii procesu,

e zvétSend zivotnost nastroju,

e lepsi vyuziti strojl,
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e rozsifeni oblasti nabizenych vyrobkl — vyroba slozitéjSich detailt.
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Hlavni vlastnosti Simufact.forming 9.0:

jednoduché, intuicni uzivatelské rozhrani,

jediny produkt na trhu, ktery spojuje vyhody solveru typu explicit a implicit,

feSeni pro optimalizaci procest jak také pro slozité analyzy a pro vyuziti v oblasti
vyzkumu a vyvoje,

nastroj pro simulaci vSech procest tvareni — zapustkové a volné kovani, za tepla i za
studena, tvarovani plecht, valcovani, mechanické spojovani a mnoho dalsich.
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Oher

1 OHREV

Nize uvedeny piiklad ukazuje proces ohiivani polotovaru prostfednictvim jiného
prvku. Diky této konfiguraci Ize jednoduchym zplsobem simulovat ¢aste¢né ohfivani soucasti
nebo indukéni ohfivani.

Ih01 2D FE lh01 3D FE

i |
h01 2D FE i
| Interpretation
l’ Temperature distribution _

Cas ke studiu: 45 minut

s\
@ Cil: Po prostudovéni tohoto odstavce budete umét

+ Sestavit model ohfevu.
+ Definovat okrajové podminky simulace.

+ Vyfesit piiklady tykajici se ohfevu polotovaru ¢i riiznych strojnich ¢asti.

B Reseny priklad
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Oher

C] vise

1.1 Sestaveni modelu

Novy projekt se definuje pomoci ikonky v levém hornim rohu

obrazovky.

Typ procesu vybirame Heating.

New = Process Properties > Heating = Hot, 2D,
FE > OK

UloZime vytvoteny projekt:

Save project as > ...

1.1.1 Geometrie
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Geometrii jednoduchych prvki Ize definovat bezprosttedné v programu funkci AutoShape:
Insert > Model >  Auto Shape >  Cylinder > R = 50 mm, L = 400 mm
Insert > Model > Auto Shape - Pipe > R OUT = 60 mm, R_IN = 52.5 mm, L =

100 mm

1.1.2 Definice okrajovych podminek

+ Definice materialu

Materidl vybirame ze zakladni databdze
programu:

Material >  Library - Steel > DIN 1.3505

4+ Parametry vymény tepla

+IGETERS
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Definujeme parametry vymeény tepla a pocatecni teploty néstroji a polotovaru.

Heat > Die > Manual >
Pocatecni teplota 1250°C
Soucinitel tepelné vymeény s prostiedim 50 W/(m2*K)

Soucinitel tepelné vymeny s tvarenym materialem 70000

W/(m2*K)
Salani do prostredi 0.25

DieTrpe

CUE plane
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Heat > Workpiece > Manual >

Pocatecni teplota 20°C

Soucinitel tepelné vymeny s prostredim 50 W/(m2*K)

Salani do prostredi 0.25

+ Definice senzorl

Kontrolni body nalozené na tvafenou soucast dovoluji
pozorovat zmény parametrii stavu. Pro jejich nadefinovani je

zapotiebi:

Kliknou pravym tlacitkem mysi na Workpiece =  Insert Particles

9

Planes

4+ Definice tabulky kontaktl

Pro nadefinovani tabulky kontaktli v procesu

FE klikneme na:
Insert > FE Contact Table

Vybereme

Workpiece =  Has contact with: vybereme ndstroj
- Near contact tolerance > 10 mm

Mode|
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Po pfidani vSech prvki procesu vypada okno objekti takto.

%+ Sit’ kone¢nych prvki

Pro vytvoteni sité klikneme na ikonu mesh

-y Process2
] W LowerDiel
(P pipe
i 1250ds
= 6) WorkPiece
T#m Mesh
(P cylinder
7 DB.DIM_1,3505
o 20
=l Particles
| Planeseti
] 20 Simulation
Ambient Temperature
| 8] Contact table
Heating

Mesh = Create new mesh E -  C(Close

=l Mesh

ve stromé procesu.
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Oher

+ Dalsi nastaveni procesu e [EE——
m;t g Elemert zize 7 SHGEIE T -
. . . = Advanced ) TP —
Klikneme na Menu Heating a definujeme 2 o - T
, v o , Jn— Peom anaka with chemens
vhodny pocet krokii procesu a dobu ochlazovani. i{ni o ot =
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Faralel S [
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1.2 Spusténi simulace procesu a vyhodnoceni

+ Ov¢éfeni zadanych udaju

Check data > OK

™ T 1|ow]ed) x|l

+ Spusténi simulace
Spustime tlac¢itkem vykti¢niku:
RUN

Po ukonceni simulace (a také v jejim pribéhu) si mizeme prohlédnout vysledky
simulace pomoci ptikazového fadku ,,Result Bar”

[Foming ] [None ] [100.00% (Model) | [ProcessTime % ~] | i@ﬂ

Postprocessing
* Animation
= Result plot

* Time history graph

MozZnosti zobrazovani modelu:

* prizraény

" ssiti
= obrysovy
= vypnuty

= stinovany
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Oher

O Shrnuti pojmi 1.1.

Jednoduchym zpisobem lze simulovat ¢asteéné ohrivani soucasti nebo indukéni
ohrivani.

Novy projekt

Geometrie

Definice okrajovych podminek
Spusténi simulace

Vyhodnoceni simulace

E Otazky 1.1.

1.

2
3.
4

Co Ize simulovat v programu Simufact.forming 9.0?
Jaky typ procesu vybirame pii ohfevu?

Jaké definujeme okrajové podminky?

. Mizeme v prubehu simulace prohlizet jeji vysledky?
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Ore:

2 OREZ

Cilem pfikladu je ukézani moznosti dérovani a ostfihovani (ofezavani). Moznosti
budou predstaveny na piikladech, ve kterych budou vyuzity rizné druhy sit¢ konecnych prvka
a rizné vypoctové metody.

Cas ke studiu: 45 minut

s\ ,
Cil: Po prostudovéni tohoto odstavce budete umét

+ Sestavit model ofezavani pomoci metody FE, FV.

+ Definovat okrajové podminky simulace.
4+ Rozdil v modulech SLMESH, OVERLAY HEX.
+ Vyfesit priklady tykajici se ofezu polotovaru, ostfihavani ¢&i  dérovani
polotovaru.
. A4 W r wr
»‘._ Reseny priklad
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Ore:

Vyklad

2.1 Dérovani (Mesh tetra)

%+ Sestaveni modelu

Novy projekt se definuje pomoci ikonky v levém hornim
rohu obrazovky

Typ procesu vybirame Trimming.

New > Process Properties > Trimming =2 Cold, 3D, FE
2> OK

Ulozime vytvotfeny projekt: Save project as > ...

+ Geometrie

V  piikladech
vytvofenou v programu:

vyuzijeme jednoduchou geometrii
- kvadr s rozméry 50x50x10 mm

Insert = Model > Autoshape > Cube shape —>X=50),
Y=50, Z=10 20K

- valec s primérem 30 mm a vyskou 50 mm

Insert > Model > Autoshape >  Cylinder shape > R=15,
H=50-> OK

%+ Definice materidlu
Material vybirame ze zakladni datab4ze programu:

Material >  Library > Steel > DIN 1.1231
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#+ Definice parametri tieni

Neni
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Madel

4+ Parametry vymény tepla mererid

Fress

Friction
. , v NN Heat _'|; br"|=r||a..
Definujeme parametry vymény tepla a pocatecni [N WorkFiece » | LiEvary.
teploty nastrojii a polotovaru. sl

-~ v r vRlv r v ¥

Cuk plang
Femove unis=d

Heat > Die > Manual 2>
x|
IrdialDie Tempeielue
Al [EETE— - |
Heax Trarsfer Coeflicient o Ambert
aﬂsn ey = |
Hest Trerafer Coefficient 1o \Workpisee

Ve . , , v rv ’ .7 i . =]
Soucinitel tepelné vymeény s tvarenym materialem 20000 ] QEM,MMH:;::LM

W/ (mZ *K) =
Salani do prostiedi 0.25 o |

Pocatecni teplota 20°C g

Soucinitel tepelné vymeny s prostredim 50 W/(m2*K)

3
3
Fress ¥
3
b

Heat > Workpiece > Manual > i
Famash 3
Pocatecni teplota 20°C DieTypo ,
Ecurdary condition F
Soucinitel tepelné vymeny s prostredim 50 W/(m2*K) ]

ryr v ’ & Workpiecs Temperatures
Salanl dO pFOStredl 0’ 25 ~\wfioFliace Tempesaiun - Initia or R sheated —
[ ] e

ﬁ  Hess Transfs Copllisiert o Arbisni ;
L] ﬂw waltim ) *
Emissivly lor Heel Riedistion b frkient

ce

Fiess |Fot | Heton |

Pt Topd | Psaale Fress I |

e

#+ Definice stroje

Press 2 Manual 2 Hydraulic 2 100 mm/s

Fnpul Spaad

=+ Ustaveni nastroji a polotovart

Prifadime geometrii a dal§i potfebné Udaje ke stromu, a nasledné je ustavime.
- Oto¢ime tak, aby osa ,,z” byla svislou osou. Vystiedéni nastroje vaci vystiizku
provedeme funkci ,,Save current position”. Vélec by mél byt ve stfedu kvadru a nad kvadrem.

#+ Sit’ kone¢nych prvkl

151 Mesh

Pro vytvofeni sit¢ klikneme na ikonu mesh ve strom¢ procesu.

Sit' nalozime modulem Slmesh tetra: 3mm >  element size to process >  close
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Ore:

+ DalSi nastaveni procesu
Definujeme libovolné nenulové posunuti (skok).

V menu ,,Substages” zvolime automatické vymazani nastroje po procesu.

+ Ovéfeni zadanych tdaji

Check data > OK

+ Spusténi simulace procesu

RUN

2.2 Oriznuti (Mesh tetra)

V této varianté procesu vyuzijeme model z predchozi I -

: Lo
Sll’l’llﬂace. Dlata Copy W resllts
Collmpss: Al

Zkopirujeme predchozi proces bez vysledkil. inset g

Increese Cies/MWPs by

Pre Window.. .

Process > Copy >  Copy without Results o Mash. .,

Open Explarer ...

Simulsbion 3

Froperties..,

% Geometrie

Vytvotime trubku - vySka 50 mm, vnitini primér 30 mm a vnéj$i pramér 80 mm
Autashape

L to shape ype IWI

Insert > Model &> Autoshape =  Pipe shape >R2=80, | st==s
F2 Radue2(0ut| : (B0

r1=30, H=50 > 0K B i, [

Heihi: ISD—
Angl|i-360) - |IJ

Length urit :

Zménime geometrii nastroje na trubku.

+ Ustaveni nastroji a polotovart

Ustaveni provedeme tak aby, se trubka nachéazela ve stfedu kvadru a nad nim.

+ Sit’ kone¢nych prvka

—1=! Mesh

Pro vytvofeni sit¢ klikneme na ikonu mesh ve strom¢ procesu.

Sit nalozime modulem Slmesh tetra: 3mm —>  element size to process =  close
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Ore:

%+ Dalsi nastaveni procesu
Definujeme libovolné nenulové posunuti (skok).

V menu ,,Substages” zvolime automatické vymazani nastroje po procesu.

4+ Ovéfeni zadanych udaju

Check data > OK

4+ Spusténi simulace procesu

RUN
2.3 Dérovani a orezavani (Mesh HEX) | : T
Collapss Al
Zkopirujeme dva procesy bez vysledkil — .

Increese Cies/WRs by

Process > Copy >  Copy without Results oo

Cpen Explarer...
Smulsbon 3

Froperti=s..,

+ Sit kone¢nych prvki
V obou dvou procesech naloZime sit’ s velikosti prvku 3 mm — Overlay hex

Modul Overlay hex: 3mm > element size to process 2  close

%+ Dalsi nastaveni procesu
Definujeme libovolné nenulové posunuti (skok).

V menu ,,Substages” zvolime automatické vymazani nastroje po procesu.

4+ StageControl

StageControl pfidame tak, ze pravym tlac¢itkem mysi klikneme v okné stromu procesu
a vybereme ,,Insert StageControl”. K novému StageControl pfiddme ptedchozi procesy.

Kliknutim na druhou polozku v StageControl a odznaenim policka pii Workpiece
upravime procesy tak, aby nebyly na sob¢ zavislé.

+ Ovéfeni zadanych Gdaji

Check data > OK
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Ore:

4+ Spusténi simulace procesu

RUN

2.4 Dérovani a ofezavani metodou kone¢nych objemi ”FV”

Zkopirujeme dva ptedchozi procesy. m— T
. vy 1 i:‘ = Hot * Cod
Klikneme dvojklikem na nézev kazdého [

v s ‘eh 1 . , v — Bimulgtion——————————
procesu a zménime jeho vlastnosti na vypocty metodou JJ’L = an &
FV. <

— Suggesied soker
) FE = Ry

4+ Dalsi nastaveni procesu
Definujeme libovolné nenulové posunuti (skok).

V menu ,,Substages” zvolime automatické vymazani néstroje po procesu.

4+ StageControl

StageControl pfidame tak, ze pravym tlacitkem mysi klikneme v okné stromu procesu
a vybereme ,,Insert StageControl”. K novému StageControl pfiddme ptedchozi procesy.

Kliknutim na druhou poloZzku v StageControl a odznaenim policka pii Workpiece
upravime procesy tak, aby nebyly na sob¢ zavislé.

4+ Ovéfeni zadanych udaju

Check data > OK

#+ Spusténi simulace procesu

RUN

O Shrnuti pojmu 2.1.

Jednoduchym zplsobem lze simulovat dérovani, vystfihovani, ostfihovani nebo
ofezavani.

metody FE, FV

moduly SLMESH tetra, OVERLAY HEX

StageControl
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Ore:

E Otazky 2.1.

o 2

K ¢emu slouzi proces Trimming?
Jaké typy metod pouzivame pro Trimming?
Jaké typy modulli pouzivame pro Trimming?

Jak ptfidame StageControl do stromu procesu?
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Péchovini

3 PECHOVANI

Cilem ptikladu je namodelovani procesu péchovani. Simulace bude provedena v
nékolika variantach — 2D a 3D s vyuzitim riznych siti konecnych prvkd.

Cas ke studiu: 45 minut

~\

@ Cil: Po prostudovéni tohoto odstavce budete umét
4+ Varianta I - 2D.

Varianta II — 3D, SIMesh.

Varianta III — 3D, HexMesh.

+ + &

Vytesit priklady tykajici se péchovani materialu.

Reseny priklad
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Péchovini

C] vise

3.1 Variantal-2D

4+ Sestaveni modelu
Vytvotime novy projekt. Typ procesu vybirame péchovani.
New > Process Properties >  Upsetting > Hot, 2D, FE > OK

Prvni proces definujeme pomoci ikonky v levém hornim rohu obrazovky.
0| | |
Meww Pr-:njeu:l:l

Dalsi etapy procesu miizeme vkladat pomoci piikazového menu:

Insert > Process

nebo kliknout pravym tlac¢itkem mysi v okné€ stromu procesu a vybrat Insert Process.

Vybereme parametry:
- 2D — dvourozmérna simulace
- FE — metoda kone¢nych prvkl

- Hot — proces za tepla

Ulozime vytvoieny projekt Save project as >  Péchovani 2D

+ Geometrie
Geometrii miizeme do procesu vkladat pomoci:

ptikazového menu Insert >  Model >

nebo

pravym tlacitkem mysi v okn¢ objektt Model =

Jednoducha télesa mizeme vkladat pomoci funkce AutoShape.
Vkladame:
Model >  Auto Shape >  cylinder > R =50, H=30-> HorniZapustka
Model > Auto Shape >  cylinder > R =50, H=30-> DolniZapustka
Model > Auto Shape >  cylinder > R =30, H= 60> Polotovar
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Péchovini

V okné objekt se ukazuji nové prvky. Pokud na né¢ dvakrat klikneme, mizeme se
podivat na jejich geometrii a vlastnosti.

+ Definice materialu
Material mtizeme nadefinovat ttemi zptisoby:
Manualné
Pomoci knihovny Simufact.Forming

Pomoci knihovny Matilda

== Friction

Type of Frictian

= A

Material >  Library >  Stal: AISI 1015 (T=800-1200C)

Plaziic Shear Frichon

Inkerfece fuchion fackor {14
%+ Definice parametrt tieni R —

Volime model podle Trescy.

Friction > Manual > Plastic Shear Friction 2 0.4

+ Parametry vymény tepla

V tomto kroku definujeme parametry vymény tepla a pocatecni teploty nastroji a
polotovaru.

Heat > Die - Manual - a postupné zaddavame
o Pocatecni teplota 250°C
o Soucinitel tepelné vymeény s prostiedim 50 W/(m2*K)
o Soucinitel tepelné vymeny s tvarenym materialem 6000 W/(m2*K)

o Sdlani do prostiedi 0.25

Heat = Workpiece > Manual = a postupné zaddavame 1100, 50, 0.25

4+ Definice stroje

Press > Manual >  Hydraulic press = 100 mm/s =  HydralulickyLis

Teplota prostredi: 50°C
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Pechovani

4+ Ustaveni nastroju a tvafeného materialu

Pted ustavenim nastrojii a polotvart je musime piifadit do stromu procesu. Provedeme
to pretazenim zvolenych objekti na vhodné misto ve strom¢.

Pti ustavovani pouzivame funkci ,,AlignBoundingBox”

Nastaveni osy symetrie

Abychom mohli provést dvourozmérnou osové-symetrickou simulaci, musime
definovat polohu osy symetrie a poloroviny symetrie.

4+ Sit’ koneénych prvki

Mesh =  Element size: 2 mm => Create New Meshﬁ = Element Size to process
-  Close

+ Parametry procesu
Pro definovani ostatnich parametrti procesu pouzivime menu ,,Forming”.

Forming -  Stroke: 15 mm >  Start

4+ Ovéieni zadanych udaju

Check data > OK

% Start simulace

RUN

3.2 Varianta II — 3D, slMesh

Simulace procesu péchovani — 3D s vyuzitim modulu sIMesh.

4+ Definice nové etapy procesu

Process 2 Insert process » Hot, 3D, FE

+ Geometrie

Model >  Auto Shape > Cylinder > R = 30, H = 60, Angle = 90 &>  PolotovarCw
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Péchovini

4+ Ustaveni nastroju a polotovart
Ptifadime prvky ke stromu procesu.

Ustaveni nastrojit a polotovarii > AlignBoundingBox

4+ Sit’ koneénych prvki

Mesh >  Element size: 3 mm (sIMesh) > Create New Mesh E > Element Size to
process >  Close

+ Roviny symetrie
Protoze je tvafena soucast symetrickd, definujeme vhodné roviny:
Insert = symmetry plane
Definice zbyvajicich parametra procesu.

Forming -  Stroke: 15 mm >  Start

#+ Ovéfeni zadanych Gdaju

Check data > OK

% Start simulace

RUN

3.3 Varianta III — 3D, HexMesh

Protoze struktura této varianty je stejnd s predchozim procesem, nemusime znovu
definovat v§echny parametry, ale mizeme vyuzit moznost kopirovani procesu.

Zkopirujeme piedchozi proces bez vysledk. == ]

Deleta o W resulis
Collapss: Al

Process > Copy 2>  Copy without Results

Insert "
Increese Cies/WPs by

Pre \Window.. .
show Mash.,.
open Explarer ...

Simulsbion L3

Froperhies. .,

%+ Sit’ kone¢nych prvki

Jediny rozdil oproti pfedchozi etap€ je v jiném druhu konec¢nych prvki, proto vejdeme

~1%! Mash

do menu ,,Mesh” a vybereme mesher ,,Overlay Hex”.
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Péchovini

4+ Ovéfeni zadanych udaju

Check data > OK

% Start simulace

RUN

3.4 Varianta IV — 3D, HexMesh — valcové usporadani

Struktura této varianty je shodnd s predchozi, mizeme tedy zkopirovat proces bez
vysledkd.

I Rerame ;l
Zkopirujeme ptedchozi proces bez vysledka. I W

Coilapse Al

Process > Copy =  Copy without Results et 8

Increase CiesWPs by

Pre \Windov.. .
Shows Mash.,.
Open Explarer. ..

Simul=bon L4

+ Sit kone¢nych prvki propertiss. ..

11 =1 Mesh

Vejdeme do menu ,,Mesh” v zalozce ,,Advanced” vybereme typ sité

,»Cylindrical”.

4+ Ovéieni zadanych udaju

Check data > OK

% Start simulace

RUN

O Shrnuti pojmu 3.1.

Jednoduchym zpiisobem Ize simulovat péchovani polotovaru.

L

metoda FE

Varianta I — 2D

Varianta Il — 3D, SIMesh
Varianta III — 3D, HexMesh

Varianta IV — 3D, HexMesh — valcové usporadani

Fakulta strojni, VSB-TU Ostrava



Péchovini

E Otazky 3.1.

9. Jaky typ procesu vybirame pii péchovani?
10. Jakou metodou simulujeme péchovani?
11. Kolik variant péchovani polotovaru mizeme nasimulovat?

12. Miizeme pouzit typ sité ,,Cylindrical* pfi druhu kone¢nych prvkia HexMesh?
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Lisovini

4 LISOVANI

Cilem pfikladu je namodelovani procesu lisovani plechu ve dvou variantich: bez
ptidrzovace a s pfidrzovacem.

Cas ke studiu: 45 minut

r \ r ror v

) Cil: Po prostudovani tohoto odstavce budete umét
4 Varianta | — bez pouZiti ptidrZzovace.

Varianta Il — s pouzitim pfidrZzovace.

Definice pruziny pridrZzovace.

- + ¥

Vyftesit priklady tykajici se lisovani plechu.

N
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C] vise

4.1 Varianta I — bez pridrZovace

%+ Sestaveni modelu

Novy projekt definujeme pomoci ikonky v levém hornim
rohu obrazovky

Typ procesu vybirdme Forward Extrusion.

New > Process Properties -> Forward ndb;::::g
Extrusion 2> Cold 3D, FE > OK Closed Die
& Hammes

UloZime vytvoteny projekt:

Save project as=> ...

[ Forqard Ertruzion
i Backward Estruzion
L Gear Forming
i Opan Die

- Bending

OEEERES

MNews Project

+ Geometrie
Geometrii polotovaru definujeme:

Insert > Model >  Autoshape >  Cylinder >R=31, H=0.8,
Angle=90 >  Lenght unit=mm > OK

nebo
pravym tla¢itkem mysi v okné objektl:
Model >  Autoshape >

+ Geometrie nastroju

Geometrie nastrojii byly pfipraveny jako soubory *.igs a
muzou byt vlozené do procesu pies:

Insert > Model > CAD preview >
sestavu (ZI_ETAP.igs)=sag=0.1

importujeme celou

%+ Definice materidlu
Definujeme novy material:

Material > Manual >  zadavame parametry:

Tnserk Taoks  Window
Process
Stageorkrol
Dz
WinirPiece

Mat=rial
Press
Fiction

Remesh

Hzlp
ol I:ll#."ld_

i Bl x|

S

Fram file. ..
CAD impork..,
CAD preview.. .

ram Resulb,

¥
»
»
He:ak: 3
3
DiaTyna 3
Boundary condrlan »
Symrmetry plane. ..

FE conkack table
Flowlines... ]
Irsert Particles...  »

Ingert Tools  window
Process
StageContral

Help |

Die =T

YWarkFicce —|
v 1

1 Fram Fil=. ..

Material 3 CAD impork, .,

Pres= L3

Frickion 3 ey ——

Hest *

Ramazh . Fronm Reslt,,

DieType 3

Boundary conditon *

Symmekry plane...

FE contack table
Flowlines, . 4
Ingert Particles. .. 3

Iadel

Press
Frizion
Heat

Rem=sh

DieType

Boondary cordizon
Lk plame

Remave Lnussd

Library...
Fram MatIDa...
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-elastic: E = 210000 MPa, v = 0.3, hustota = 7850 kg/m3, vodivost = 45 W/m/K, mérna
teplota = 420 J/kg/K

-plastic: S = 227 MPa, C = 524 MPa, N = 0.219, prdace preménéna na teplo — nediilezite,
dilatace = 1.5e-5 1/C, referencni teplota 20° C

(picbon _________________E

4+ Definice parametrt tfeni S
wp= of Friction

Postupné definujeme tii rizné koeficienty tfeni. s \:l ||C AN

Volime model podle Trescy. Coudrn Frstcn

Static Hiction eosficiani [| [0.0 - 0.5]

Friction » Manual > Mix: Coulomb: 0.05; Tresca: | sumsspexrisen
02> mix005 Irkesface fiction lactee [ [0 1] Jo2

0.05

Material

%+ Parametry tepelné vymény s

Friction

1 /. b4 4 v 7 Heat Manual....
Definujeme parametry vymény tepla a pocatecni teploty [F= R
, .o DieType
nastrojui a polotovaru. Bourdar corciton >

Cuk plane »
Remove urs=d

Heat > Die > Manual >

+# Die Temper sture

Pocatecni teplota 20°C g G i

Hesal Tiarsar CoeMMician! 1o Ambent

Soucinitel tepelné vymeny s prostredim 50 W/(m2*K) b E CEE—

Heat Trarafer Coefficient fo s orkpiece

Soucinitel tepelné vymeény s tvarenym materidlem 20000 || g e 2l

Errisziaty fer Haat Fadiation ba &roien)

W/(m2 *K) o 1011
o |

Salani do prostiedi 0.25

& Workpiece Temper ature |
Heat > Workpiece > Manual > :’ '“‘“"EW%‘

V7 v o7 ﬁ\ e Tran efficient bo Ambieni .
Pocatecni teplota 20°C P ”‘;m”‘m ]
Soucinitel tepelné vymeény s prostiedim 50 W/(m2*K) |:| E%;",w&ﬂmw"*

U3]]
Sdlani do prostredi 0.25 Carcl
Teplota prostiedi

Strom procesii > & 5 2°c e 3

4+ Definice stroje

Press > Manual > Hydraulic > 100 mm/s e[ —]
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4+ Ustaveni nastroju a polotovart

Nastroje a polotvary ptifadime do stromu a nasledné ustavime =  a oto¢ime tak, aby
osa ,,z” byla svislou osou. Pro vycentrovani nastroji vici vysttizku vyuzijeme funkci ,,Save
current position”.

Protoze provadime simulace pouze Ctvrtiny vystfizku, musime zvolit vhodné roviny
symetrie.

+ Sit’ kone¢nych prvku

. . 121 Mesh
Pro vytvorteni sit¢ klikneme na ikonu mesh ’ ve stromég procesu.

Sit nalozime modulem Sheetmesh: 0.6 mm, 4 prvky na tloustku = element size to process

-2  close

%+ Parametry procesu

Forming >  Stroke 2> 20 mm

4+ Ovéieni zadanych udaju

Check data > OK

4+ Spusténi simulace procesu

RUN

4.2 Varianta II — s pridrzovacem

V tomto procesu vyuzijeme strukturu s ptredchézejici etapy.

Zkopirujeme ptedchozi proces bez vysledkl a pfidime |gr—

Drdita

dalsi néstroj — ptidrzovac Callopas Al
. ;::::lse Cims/WPs by g
Process > Copy 2>  Copy without Results T,

Shows Mash .,
Cpen Explarer ...

Smul=bion »

Properties..

+ Definice pruZiny pfidrzovace
Die type 2  Die spring 2> Manual
Tuhost: 1 N/mm;,

Pocatecni sila: 975 N;
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Lisovini

Smer: -Z; iffess |'| [Mewtar/rrm |

Displacement: 1.6 mm, Iritalfarez F (1 |375 [Mewtor =]

Direcion D[] & % € vy  Z D il A i)

Dizplacement | |1 &

r Initial condtion - The springis...
o+ Teplota prostf‘edi " released (¢ compressed by the given masmoum displacement |

Initial condition: compressed

Strom procesii > - & > 20°C

=+ Ustaveni nastroji a polotovaru

PtidrZzovac ustavime tak, aby byl 0,8 mm nad pfistiihem.

#+ Sit’ kone¢nych prvka

. . "151 Mesh
Pro vytvorteni sit¢ klikneme na ikonu mesh ’ ve stromég procesu.

Sit nalozime modulem Sheetmesh: 0.6 mm, 4 prvky na tloustku =  element size to process
> close

=+ Parametry procesu

Forming >  Stroke > 20 mm

+ Ovéfeni zadanych udaji

Check data > OK

#+ Spusténi simulace procesu

RUN

O Shrnuti pojmu 4.1.

Jednoduchym zplsobem pomoci programu Simufact.forming lze simulovat lisovani
plechu.

Varianta s pridrZovacem
Varianta bez pridrZovace

Vlastni definice materialu
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Lisovini

metoda FE — modul Sheetmesh

Definice pruziny pridrzovace

E Otazky 4.1.

13. Jaky typ procesu vybirdme pfi lisovani?
14. Jakou sit’ kone¢nych prvkii nanaSime na plech pii lisovani plecha?
15. Jaké varianty lisovani plechu miizeme nasimulovat?

16. Jak nadefinujeme pruzinu ptidrzovace?

Fakulta strojni, VSB-TU Ostrava



Valcovani krouzku

5 VALCOVANI KROUZKU

Zakladem procesu je tvafeni krouzka s vyuzitim vnéjSiho hnaného tvéfeciho vélce a
volné se otacejiciho vnitiniho vélce. Ke tvarenému krouzku jsou dotlatované ptidrzujici valce
a bocni valec.

~
¥

eV
o5
o paos”"
rird

Cas ke studiu: 1 hodina

‘~\ - }
) Cil: Po prostudovéni tohoto odstavce budete umét
Modul ,,Ring Mesh*.

Definice poctu ¢asovych krokt pfi valcovani.

=

Lokalni soutadné systémy.
Slozeny tabulkovy pohyb.
Nepohanéné (volné) nastroje.
Stabilizace.

Vytesit priklady tykajici se tvareni krouzkda.

Reseny piiklad
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Valcovanit krouzku

C] vise

5.1 Stavba modelu
Novy projekt definujeme pomoci ikonky v levém hornim rohu obrazovky
Typ procesu vybirame Ring Rolling.

New = Process Properties 2>  Ring Rolling > Cold, 3D, FE > OK

Ulozime vytvoteny projekt: Save project as =

+ Geometrie

Geometrie nastroji byly pfipraveny jako soubory *.stl a mlzou byt vloZené do
procesu:

Insert > Model > From file > vybirame vsechny IS —
soubory *.stl ze slozky Vater il Y CADinpot...
Press b CAD preview..
Friction 3
nebO - ,  Autoshape.,
pamesh y | Frambesls
’ 7 N X : o, LieTyp= 4
pravym tlacitkem mysi v okné objektii: T e+
;o v Cukplane k
Model>  From file=> vybirame vsechny soubory *.stl ze Rarave Lrused

slozky

. ., Madel 5 [inemre e o teany x|

#+ Definice materialu N oo "B REL L

., Press k P DHH_1 ADORT =200 %

Material ~ vybereme ze | e b FromHalDs.. el

B i i Heat 4 [%G¥ DIH_1 4034 =ZT-1100C] g
zékladni databaze programu: Remesh ’ o e
CieT e k DI 1 T-1z0])

. . Boundary condbion [ 01 4201 T =20 100E 4
Material -> Library > Steel 2l ' o et
> DIN 1.3505 e TR R

+ Definice parametru trent ~Tupa ofFicton

Postupné definujeme tfi rizné koeficienty tfeni. Volime Q = Q M‘
model podle Trescy .

Friction » Manual > Plastic Shear Friction > 0.3, 0.85 a | ™™™ —_— ‘

Intantacs fiieion lactor (m) [O- 7]
0.00

Modal »
A Jm e Materizl »
% Parametry tepelné vymény e '
. I W v r W r Fr‘j:m K

Definujeme parametry vymény tepla a pocatecni teploty |IEEEEEL NN TR

o Femesh r WorkFiece ¥ Library, .

nastrojii a polotovaru. DieTvpe ,
Ecurdary cordilion B
CUE plane »

Remove Lrssd
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Valcovanit krouzku

# Die Temperature
Heat 9 Dle 9 Manual 9 @- ﬁ‘ Iniial Die Tempeialuie
A [Erre—
Pocatecni teplota 20°C mr;; Lo
ol Al -
Soucinitel tepelné vymeny s prostredim 50 W/(m2*K) &9 ﬂi‘;];m‘“‘ﬁa:&mw” 5
Ve . 4 , v v r . : Emissiwitp for Heat Fadistion b Ambien!
Soucinitel tepelné vymeny s tvarenym materidlem = )
20000 W/(m2*K) |

Salani do prostredi 0.25

Heat 2 Workpiece 2 Manual 2>

Pocatecni teplota 20°C

Soucinitel tepelné vymeny s prostredim 50 W/(m2*K)

Sdlani do prostredi 0.25

4+ Definice stroje
Press 2 Manual 2 Tabular Motion
Table type = Time/Velocity

Time — 0.00 sec = Translational velocity
Y -1 (mm/s) 2> Angular velocity 100
ot/min=> Add=> OK

Time - 3.16 sec =2 Translational velocity
Y -1 (mm/s) 2 Angular velocity 100
ot/min=> Add-> OK

Press 2 Manual 2 Tabular Motion

Time — 0.00 sec, =2 Translational velocity
Z 0.8 (mm/s) 2 Angular velocity 0 ot/min
2 Add 2 OK

Time — 3.16 sec, 2> Translational
velocity Y 0.8 (mm/s) -  Angular velocity
0 ot/min > Add—-> OK

=ik Piace Temperatie - Inital or Raheated —
[ ] T -

ﬁ‘ Heat Transfer Caefliciert tn Arbi=nt

L] {50 [watbtmze) =]

Emissivdy lor Heek Radiation ko Ambient

‘@'Mi 0]
Carcel

Madel

Material

Press

Frickion

Heal

Remeash

DeType

Boundary condiion
Cuk plane

Remaove Lnused

Library. ..
Kinematics. ..

- v v v v vRiTr v

Fress |P|ar ]Him-ul

Pres: Tope | Tebokes Hobien [T iaralefion & Fedeo =l

— Tabular Moo | Tranzkabion & Pt 1

Tabkboe: [Tnariecay =]
Tim= Tranzlaional velociy BLAYE) Angda velocitp
B [o F F [
I::C:'c J |-" ser J ||:'Ji:| TN d
Tiina: | Tiarslvd & | Tiarelval' | Trdvel 2] Angeal | - (S o
0 0 B 0 10 LI =
318 a -1 L} 100
¥ od [
Read lipmbsibe o file
s W I

Pros | Pl | Histony |

Fraze Tupe | o Miovion [Tiaistion & Rotstior d

Takadar Malox [Transkion 2 Fotalon]

Tebde hpe | Tiveekaiy =
Tin= Transletional welocty (/2] Argular weinchy
P " P E P
|1~:c':1 j |'" 580 j |':\-\:':‘|"\1 j
Tine Tiarslwel. % | Transluel ¥ | Trandwel Z | dngwel : F oo
e § 1 % § |t
l
radity I Llehete
Riead fromdvaite to lle
- wlilE
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Valcovanit krouzku

4+ Okrajové podminky nastroji

Definujeme, ve kterych smérech hlavniho soufadného systému se nastroj nebude moct
pohybovat. Vytvotime dva stejné objekty. Pojmenujeme je ,,z” a ,,w”.

DieType > Dielnsert > Manual

Po ptidani vSech prvkl procesti bude okno objektli vypadat nasledovné.

Processes ———— g x|
=-fip Process Hame
g tlppergfe € DB.DIN_1.3505(T=20-1...
i Lowertie (P axialral1
EV :bnifgiflﬁc:em k G ka2
. pera ( centerrall
(P mand-el
G ring
G roller
B m0.3
i
ERm0,85
W c20
W czo
':a rok-trans
Etrans

S

5.2 Definice osy otaceni nastroji

V okné objektt klikneme pravym
tlacitkem na:

axialroll =>  Rotation axis/local systém r
= urcujeme 3 (pouze pro osu otaceni)
nebo 4 (pro osu otdceni a pro souradny
system) body na hrané jedné rovinné plochy

Ikonu v levém hornim rohu pouzijeme pro zménu sméru otaceni.
Pro vymazani bodi, které urcuji osu ota€eni, pouzijme ikonu.

Pro editaci jednotlivych bodli vybirdme jeho ¢islo a nésledné¢ v pracovni oblasti
birame jeho novou polohu.
v JERO MOVOT pooht PortNi 1 < | > |
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Valcovani krouzku

Menu vybéru v pravém dolnim rohu slouZzi pro definovani, ktery soufadny systém se
bude pouzivat pro otaceni, a ktery pro posuv. Vybirame ,use for

rotation”.

Tento postup opakujeme pro zbyvajici néstroje.

V okné objektl pravym tladitkem na:

Centerroll - Rotation axis/local system
- definujeme 3 body na hrané jedné rovinné plochy
- use for station > OK

[~ use for tranglation
¥ wuze for rotation

Mandrel - Rotation axis/local ~ systém
> definujeme 4 body na hrané jedné
rovinné plochy >  use for rotation > OK

roller =  Rotation axis/local systéem =  definujeme 3
body na hrané jedné rovinné plochy =  use for station
2> OK

Fakulta strojni, VSB-TU Ostrava



Valcovanit krouzku

5.3 Prirazeni prvki procesu ke stromu procesu

Vytvotené prvky procesu by se mély pfifadit ke stromu procesu. Abychom to mohli
provést, musime vytvofit nové nastroje.

oM
!
5

. DT _1,3505(T=20-1,
RMB Proces = Insert > Die LB e ol

Colzpze Al Hrollz

nebo

EEE Increase Dies/'WPs by WicrhFiece. ..
i Symmetry pflane

Increase Dies/WPs by . Fe cortact tale

Op=n Explorer... I
T

£
m Sirnu ation 3

Prapattizs...

Jména nastroji musime zmodifikovat souhlasné se ﬂm' """ DieType R
jmény, které byly nadany geometrii nastroji (mandrel, %a’“a'_“ Copy

Rename

Delete

axialrolll, axiaroll2).

Po pfitazeni vSech prvki by mél strom procest vypadat nasledovné:

= @ iw AI — 1 Bl x|
= ‘ﬁ rok-trans Mame
=i roler ¢7DE.DIN_1,3505(T=20-1,
9 raller 9 axialrolll
% ?2%85 9 axialroll2
9 cenkerroll
B trans & mandrel
= ﬂ LowserDie .
E, centerr arlng
R mo 9 roller
@ 20 EBm0.3
= @ mandrel =m0
£P mandrel EBm0.8s
mo.3 W20
A 20 ez
g SHyrot-trans
=81 |v&'orkF'iece ‘ﬁrrans
0 Mesh 2
G ting %w
CB.DIN_1.2
3 c2i
= Fialrolll
@ P axialrolll
md.3
A c20
S w
= Fxialrollz
@ 9 axialrollz
= mo.3
A c20
S W
g #Ambient Tempe__|
4 Forming -
4] | R | >

+ Sit’ koneénych prvku

vt ix1as . L5 Mesh
Pro vytvoreni sité klikneme na ikonu mesh @ *-

ve stromé procesu.
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Valcovanit krouzku

V zalozZce “Advanced” definujeme parametry sité¢ pro modul “Ring mesh”

Advanced > Menu — General 2  Radial,
axial element size — 4 mm, tangential — 3
mm > Menu — Rotation >  Ring axis: X-
axis 2> Menu — Quality > Maximum

refinement level 1, quality -
0,001> OK

outline

Mesh = Create new mesh ﬂ -  Close

% Zapnuti stabilizace modelu

Pti

procesech valcovani krouzkii se
doporucuje zapnout stabilizaci modelu.
+ Vypocet poctu Casovych kroku

V  procesech valcovani je moZnost

2
A\Y
Inpt for besrer bo Creste o few Mesh
Ehemert sz |4 i

Advaroesd

WarkMece

Pleshe L i

Elenert ippe el 3+ |

automaticky zvolit pocet casovych krokd v
zavislosti na nadefinovanych parametrech modelu.
Pocet casovych krokid se pocitda na zdkladé
poloméru (R) hnaného vélce, obvodové rychlosti

(o), celkového Casu procesu (T) a velikosti prvku

te¢n¢ k povrchu nastroje (3¢) ze vztahu:

2nRwT
n=——
e

4+ Ovéieni spravnosti zadanych udaja

Check data > OK

4+ Spusténi simulace procesu

RUN

] Forming Conrol (FE)

Sroke
Elamark simkrnn [¥ Uz Stebizrg Spngs
ki Divisiars
it Reaits Silinmes 10N Pl
Substages
= Adyareed
m“"“ ¥ Sprng tfreund
CantectiRezase Auial Slingss [100000 n
Frictacd
awin Fotation fude [A] -
Symmetry
Perdel
Smhibs
o
s Forming Comtrol (FE) %
Fraks
Blarent: dzejtype tnda
QU Ciisians v Fiwed lime shepes
Output Readts
Subchages 7 Adaptive trne stepe
= el
Soep conirol
Salvar
pertaneseo) Peboont SR -
Friction
g::::‘aw Distance persten (] |1 i m
Farlel 1111143 0 e angenial aleruee: size, . pt 1 peciliec)
Sebize
I8 A
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Valcovani krouzku

[Effecihe Prastic Sirain #

4280
T

fz

‘i__

Process ADMURES fFabieprass)

O Shrnuti pojmu 5.1.

Valcovani krouzkta pomoci programu Simufact.forming 9.0.

Stabilizace procesu

SloZeny tabulkovy pohyb
Novy modul RingMesh
Vypocet poctu ¢asovych kroki

E Otazky 5.1.

17. Jaky typ procesu vybirame pii valcovani krouzku?
18. Jakou sit’ kone¢nych prvki nanasSime na valcovany krouzek?
19. Jakou cestou nadefinujeme vlastni stroj?

20. Mtizeme nadefinovat i nepohanéné (volné) nastroje?

Fakulta strojni, VSB-TU Ostrava



Protlacovani - ECAP

6 PROTLACOVANI - ECAP

Cilem ptikladu je namodelovani procesu protlaCovani rovnostrannym pravouhlym
kanalem technologie ECAP (Equal Channel Angular Pressig) umoznuje ziskat ultra-jemné
zrmo ve vétSich objemech, kdy se pfi vlastnim protlatovani nezmenSuje vychozi piicny
praiez. Vysledkem piikladu je prohloubeni znalosti o deformacnim chovani kovovych ultra-
jemnozrnnych materidlt (nano-materidlll) a vlivu plastické deformace na strukturu,
mechanické vlastnosti a tvafitelnost.

- B
Y .

Process

Cas ke studiu: 45 minut

s\
@ Cil: Po prostudovani tohoto odstavee budete umét

+ Sestaveni procesu protla¢ovani.
+ Vlozeni pfeddefinované geometrie.
+ FE — mesh Overlay Hex.

+ Deformac¢ni chovani kovovych ultra-jemnozrnnych mateirali.
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Protlacovani - ECAP

B Reseny priklad
O] s

% Sestaveni modelu

Novy projekt definujeme pomoci ikonky v levém hornim rohu obrazovky.

Bulk Forming &
i Upzetting

e Cloged Die
New > Process Properties 2> Forward | - Hane

Typ procesu vybirame Forward Extrusion.

Extrusion 2 Cold, 3D, FE > OK | oiard Ertruzon

i~ Backward Extruzon
i Giear Forming

Opzan Die

i Bending

Ulozime vytvoieny projekt: Save project as—=>ECAP

% Geometrie

Geometrie nastroji i polotovaru byly pfipraveny jako soubory *.stl a mohou byt
vlozeny do procesu pfres:

Insert > Model > From file... > importujeme vSechny soubory polotovar ECAP.stl,
nastroj ECAP.stl, prutlacnik ECAP.stl

& File Edit View Inset Tools Window Help

FEREE

Processes

& -fn ECAP
nebo & o
o LoweDie
) WorkPiece
“ f Ambient Tempei

pravym tlacitkem mysi v okné objektt:

Model > From file... > importujeme vSechny
soubory polotovar ECAP.stl, nastroj ECAP.stl,
prutlacnik ECAP.stl

3 1A 14 . "_"
+ Definice materialu pro nastroje Insr e rom i
EEH Materials G SK-T
.7 ror r s ’ By Aluminum sk
Materidl  vybirame ze zdkladni databaze B Coen @50
programu: e oo
- B T
Material> Library—> ToolSteel> 5 BB
By Zircalioy
AISI to JIS> SKD6I T Zrcerun

Poperies.. | Load | Close
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Protlacovani - ECAP

+ Definice materialu polotovaru

serttem from Uorory SR oo |
Material Vybiréme ze zakladni databaze programu: T Materids o551 =240 480C)
G A4_BOB1(T =20C)
=3y %pﬁlel 7 &4 _BOB1(T=250-500C)
. . .. spanese :
Material > Library > Aluminium > EC 1350 )
@D\N_3.2315
= iy S_tee\ < [EE C
( T 2 0 C) By Titanium @jsnﬂzz-wnm

ToolSteel
iy ToolStes <@ SuperPure{T=200600C)

@y Zicalay
[y Zirconium

< [ M v

Froperties... Load Close

+ Definice stroje

Proces je provadén na hydraulickém lisu s
rychlosti 0,5 mm/s

Press | Plot | History |

Fress Type  [Hydraulic Press
Press—> Manual-> vybereme Hydraulic Press, (EIN
. 14 . r 14 o v P s :I
Lis mad linearni priibéh, rychlost = 0,5 mm/s J i L Sl T a—
> 0K EH —
Velociyly) 05 mmisec -
Nazev = HydrLis

%+ Definice parametri tieni

Postupné definujeme tfi rtizné koeficienty tfeni.
Volime model podle Trescy.

L/ b| |t AN
Friction = Manual 2 Mix: Coulomb: 0.05; Tresca: Ru -
0.2 > mix005

% Frachion

0.05

Sualic fiction cosfficient | (0.0 - 05]

" Plzsitic Shear Friction

Iricerfacs fiiction lactor (ml [ - 1] Iggi

J4 4 W Model 3

+ Parametry tepelné vymény ot ,

Fress 3

Friction 3

‘ Definujeme parametry vymény tepla a pocatecni teploty  (mezas R

nastrojii a polotovaru. DTI02 ion s
Uk plane

:c:n‘;rcmmd '

Heat > Die > Manual >

Pocdtecni teplota 20°C e lmwoene

@- ﬁ Iriie| Die Tempeiaiue

o L S A I FEET—- |

Soucinitel tepelné vymeény s prostiedim 50 W/(m2*K) Hoak Trrle Coelon oAb

E 0 [watrAma =] =l
Soucinitel tepelné vymeény s tvarenym materialem 20000 gmmmﬁ;&\:ﬁm 5
W/(mZ *K) : E minsivity fer Hs: Fladistioe, b &nien)

@m‘s o

Salani do prostredi 0.25 Cael |

- DieTemperature2()
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Protlacovani - ECAP

Heat > Workpiece > Manual >

Pocatecni teplota 20°C

Soucinitel tepelné vymeny s prostredim 50 W/(m2*K)

Salani do prostredi 0.25
>  WPTemperature2()

+ Teplota prostiedi

A& >20C

Strom procesii >

+ Ustaveni nastroji a polotovart

Nastroje a polotvary prifadime do
ktery by mél vypadat nasledovné.

+ Sit’ kone¢nych prvki

& Weorkpiece Termper abure =]
~wforkFiace Temperanae - Inilia or A eheatsd —
[ ] % o
Heat Transfer Caellicient b Amrbianl
' gl WAt
Emissivily lor Hest Fiadistion ba rrbient

i Processes
B fy ECAP

stromu,

Pro vytvotenti sité klikneme na ikonu mesh

-5 HydrLis
- UpperDie

~( Prutlacnik_ECAP

) DieTemperature20

@ LowerDie
L Nastroj ECAP

eTemperature20

B )} WorkPiece

. Mesh
Polotovar_ECAP

4> DB.EC_1350(T=20C)
.4 WPTemperature20
A Ambient Temperature
@ Forming

o

MName | Type

Material
Material
Model
Model
Model
Press

< DB.EC_1350(T=20C)
7 DB.SKD6L

G Nastroj_ECAP

(P Prutlacnik_ECAP
(# Polotovar_ECAP
? HydrLis

mix005

ﬁ! DieTemperature20
¥ WP Temperature20

Friction
Heat
Heat

ve strome procesu.

Sit’ nalozime modulem Overlay Hex: 1 mm >  Create New Mesh ﬁ -  Element Size to

Close

process >

+ Parametry procesu

Forming =  Stroke = 33,5 mm

+ Ovéfeni spravnosti zadanych udaju

Check data > OK

+ Spusténi simulace procesu ECAP

RUN

Pratlacnik

Vzorek

Nastroj

90°
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Protlacovani - ECAP

O Shrnuti pojmu 6.1.

Simulace protlacovani procesu ECAP pomoci programu Simufact.forming 9.0.
Protlacovani rovnostrannym pravouhlym kanalem
Plastick4 deformace

Vyhodnoceni intenzity deformace

E Otazky 6.1.

21. Jaky typ procesu vybirame pii dopfedném protlacovani?
22. Co ndm umoznuje dosdhnout proces ECAP?
23. Jaky typ modulu pouZzijeme pii definici sité na polotovar pfi procesu ECAP?

24. Co vyhodnocujeme u simulace procesu ECAP?

Fakulta strojni, VSB-TU Ostrava



Kombinace procesii

7 KOMBINACE PROCESU

Cilem priikladu je namodelovani procesu tvareni za tepla. Bude nasimulovan proces
kovani zavésu s okem. Simulace prob¢hne ve Ctyfech etapach — prvni — chlazeni, dalsi —
tvareni.

Cas ke studiu: 60 minut

~\
Cil: Po prostudovani tohoto odstavce budete umét

4+ Sestaveni simulace kombinujici vice procesa.
Simulace chlazeni.
Simulace objemového tvareni — péchovani, zapustkového kovani

Definice senzort, definice bodu.

- + &

Ustavovani nastroju a polotovaru.

\& Reseny piiklad
s
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Kombinace procesi

C] vise

7.1 Etapal - chlazeni

Simulace procesu chlazeni.

Vytvotfime novy projekt a nésledné prvni
procesu. Typ procesu vybirdme chlazeni.

New = Process Properties >  Cooling

Volime parametry:

- 3D — trojrozmé&rna simulace

- FV — metoda konecnych prvki

- Hot — proces za tepla

Save project as >  Chlazeni

#+ Geometrie

w: P . D=plh 4m
soubor *.stl. Plosinu, na které budeme ochlazovat, vytvotime hegn: [0
funkci AutoShape.
Polotovar Lenghoinit: [ibmetr ]
coa |

Model > From File > Chlodzenie Wsad.stl

Platforma

Model >  Auto Shape > Cube > 400 x 400 x 100

mm

Nazev =2 Platforma

V okné objektl se ukazuji nové prvky. Pomoci
dvojkliku se miZzeme podivat na jejich geometrii a

vlastnosti.

etapu
Process properlizss

Fragrg
% Hol ™ Cald
Eirndalion
L. 1 Ol 1]
Sanguziad aohem
™ FE & Py

AutoS hape 1%
Autoshape bpe Cube shape -
Shape Siza

Polotovar pro proces chlazeni byl pfipraven jako @[H L

A
v
Range
w|  G58%5.) 55825 mm Facels| 78
w[ 55625.] 5585 mm Volume| 302914 cm3
Z[ 15a7es-[  154.788 mm

Fakulta strojni, VSB-TU Ostrava



Kombinace procesi

Ineert ftem from Library

% Definice materidlu i ey B

B g E:E:m [P S_1002-B[T=200) Gras

. . _ G AIS_ImOT=a0E) S
Material >  Library - Steel > AISI 1015 (T=800- - M P ERECI N P
M Thawum e e

1200C) A % Lfff Kpus_man=ariazsn gl
R Zresiiy S ASI_1020T-20T) Al

T Zreerm S I0SETSAE GHAIS

A1 T=20-300C GG

[ IS1_1045|T=20-300C| grals

€l »

Propeies.. | Loed | O |

4+ Definice parametrt tfeni == Friction

Vybirdme model podle Trescy.

Friction » Manual = Plastic Shear Friction 2> 0.4
Ndzev 2 m04

Flashc Shear Fiiclion
Irimibaces fiction Facior |':|"

(o] eoen|

+ Parametry tepelné vymény

Definujeme parametry vymény tepla a [
~ 7 ~_ 7 4 b Iritisl Dim TempeiaLan
pocatecni teploty nastrojii a polotovaru. n & o -
Heal Tiensler CosFiviand loAmbiank
i Elsl:l [edattmizt)

@ Heal T isder Coelficand ko' oikpsce

ﬁlﬁlm [rwamame ks =
.. . , , . . , I:l Ewmigzny lor Heat Aadislion bo Ambent
o Soucinitel tepelné vymeny s prostiedim 50 £y I
W/(m2*K) Cancel
o Soucinitel tepelné vymeny s tvarenym
materialem 6000 W/(m2*K)

Heat > Die 2> Manual 2> postupné zadavame:

o Pocatecni teplota 150°C

@] Sdldi’li dO pVOSl‘}"Vedl’ 025 | & Workpiece Temperalure \
ok Fiaca Tempetaliae - Inbal o Bekeated
Pojmenujeme =2 Name Chlazent ¥ E Cebine £

‘@ Heat Trarefar Coelficieant b dmbis
L] . B WatldAmrE] =]

Heat > Workpiece > Manual -> postupné A b e Gl s
[0z 1
zaddvdme 1200, 50, 0.25 [ ] = -

[ok | oo
Pojmenujeme 2 Name T1200

E Froc=ss=s

oL | —
o I g
[f Lowerniy  DieTypa ] |

* Definice nastroji & Workker ooy
frnbient  Aenams

P

V tomto kroku nebudeme potiebovat vSechny el
rarsiale
nastroje. VymazZeme proto ndstroj UpperDie a nechdme Aign Baurdngo

pouze LowerDie a Workpiece. Pasitiaring '
Oznacime UpperDie ve stromé 2 RMB 2 Delete .
Propertias...
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Kombinace procesi

Takto ptfipravenou sestavu parametrii procesu piifadime ke stromu procesu:

; E
=-[ip chiodeenie [T—
5 i LowerDie OB, ALS]_1015(T-200-1.
E P‘;:‘orma aCHod:enia_Wsad
= m
A Hodzenis gn;:‘nrma
= WorkPece 'tﬂlg-l deeri
(o Hodzenie_wsad @ pzenie
3 CE.AIS]_1015(T-80 Tizm
W 11200
ambient Temperature
Cacling
,:j-':: Ambient temperature EI
%+ Teplota prostredi
|ﬂ |Cc|.sius j
Strom procesii > A >0 e | Cancel
Align BoundingBox...
Algn b o thiz componenl ..
Position Setal o
#+ Ustaveni nastroju a polotvart e — I
iy |Gk =
’ e . . . M|
Pro ustaveni pouzijeme Align BoundingBox (na WorkPiece). N M
o the b of | LoEe -l
Poalion Seealin:
e Cenben =1 Keep
LCanter
in'T Cerl=r :I" ML
nZ  |Cerz hd Mak
. Czresl

Vci sobé vystfedime ploSinu a polotovar.

Ptfesuneme polotovar nad ploSinu a gravitaéné ustavime tak, aby upadnul na ploSinu.

=+ Parametry procesu

s ettinegs
r 7 , ° Cugeppat Civinora - G
Pro nadefinovani zbylych parametrt ok ke WokFecs Elneni S | =
.. . S Adsarcnd Diim Elarruard Sicm [] 0 o
procesu pouzijeme menu ,,Cooling”. oo d
Cockng e f e
Cooling > Basic settings —> velikost Mannta dbagk 4 T
prvku 10 mm, cas ochlazovani 6 s s
[™] F ank ka xera, | ha vcthpisce slsvard o @l ke usad
__o |
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Kombinace procesi

%+ Definice senzort

RMB
S

-  Insert Particles

Planes

Vytvétime 5 rovin na délku,
S parametry:

Pocet ¢ar: 5
Pocet vnitinich bodii: 2

v

Pocet bodii na vnéjsi care: 50

Diis P oyl

T

v

%+ Ovéfeni spravnosti zadanych udaji

Check data > OK

#+ Spusténi simulace procesu

RUN

7.2 Druha etapa - péchovani

Prvni etapa tvafeni -
lichobéznikovych kovadlech.

Definice nové etapy procesu

Process > Insert Process >  Upsetting > Hot 3D FV

Nazev 2 Etapal

#* Geometrie
Model > From File 2>
Model 2> From result =

=+ Parametry tepelné vymény

Definujeme parametry vymeény tepla a pocatecni

teploty néstrojii a polotovaru.

Heat > Die > Manual > postupné zadavime:

zaobleni

Process properiiss

polotovaru na

=
- Foigra
= Hot T Cad
Bimizbion
o a
Suuggested sohie
™ FE Py

Etapl MG, Etapl MD
Chlazeni 100 %

g o

[ ]

Iridal Die Termnershrs

A{l—m Celsue LI
Hei: Tranelier Coallicisnt b Ambisnt

@|SD il Ak |
He=st Transher Coslicient bo Workmece

ﬂp&m [WatmEE) B

Emizeraly 101 Heat Radiation o Ambert

ne i)

Cancal
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Kombinace procesi

o Pocatecni teplota 150°C
o Soucinitel tepelné vymeny s prostiedim 50 W/(m2*K)
o Soucinitel tepelné vymeny s tvarenym materidalem 25000 W/(m2*K)

o Sdlani do prostiedi 0.25

Align BoundingBaox...

Mg bow for this componen...
Fezlon Sel albx
Nazev =2 Proces o etz Et':
N =
n
T - Mas I
roA ‘o ° hd
#+ Ustaveni nastroju a polotovart 1 the boof | SAEE
Fralion Sal al b
Vypneme UpperDie nx (et ey
Catbar
. . i Lenter hd
WP > RMB -> Align Bounding Box e Hin
n? Cerder vI Mz
ITI Cancel I

Pteneseme WP po ose Z nad LowerDie.

Gravita¢n¢ ustavime WP
Zapneme UpperDie a pfesuneme nad WP

Gravitacn¢ ustavime UpperDie

% Definice stroje Ptne. [ianicie: 5

=N

R Sk o

Proces je provadén na hydraulickém lisu s
rychlosti 250 mm/s.

Nazev 2 HydrLis
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Kombinace procesii

% Definice bodi

Definujeme body na vodorovném povrchu

nastroju.

4+ Definice dal$ich parametrii procesu
Forming >  Stroke >

Vybrat nadefinované body a jako kone¢nou
vzdalenost mezi nimi zadat 20 mm.

Forming >  Element Sizes > 10 a 10 mm

%+ Ovéfeni spravnosti zadanych udaji

Check data > OK

=+ Spusténi simulace procesu

RUN

T
|Meme | vy ’
DB, ASL_1015(T-300.1,. Ptifazeni ke stromu procesu.
GChIodzenie_Wsad
GPIatForma
Z==mld
"Chlodzenie
Efﬁ LowerDie W11200
© e Erapi_MD (Perap1_ra
[(PEtap1_vD
: (P CHLODZENIE_WORKPIE.,
E‘@ "Proces
[ @ CHLODZEME WiORk ':'ia’PrasaHydr
> DB.AISI_1015(T=580
¥ Tiz00
Ambient Temperature
Forrming

| Farming Contrai (FV) | X

Stroke
Bheverk Soss
ulpd Divishre:
Oufpk Resks
Sal v CpEinizE
= dovancad
Sabewr
EETRAON
“Contect
e vonirol
~Miselane s

Dirscicn

. = == Bhan Conie.
Frasds poit Dt pan

[F2 G |

Inid clatence N2 [EHEEERE ) o,

Ditaros o 005 chokn |71 o |

eiks i a ehicks al fetE=STed] oy

(o] oo

ok I A

e
Eewest Skes
Cutpt Deddens
OutpLt Rk
- Saber Dotk
= ddenced
Salver
RET/MON
Corcact
Sbap contral
Hiscel ke

& Forming Control [F¥)

[ w——l m

Diim Elemary See [7] [1m s

Mzwrumrbet ol D s £l WPk

17 F et bozewn, skt it b setwhen needed fist e,
I [ 2et 1o zerme e otk pivos: elament sze vl be wiad.

S | T

Fakulta strojni, VSB-TU Ostrava



Kombinace procesi m

7.3 Treti etapa - péchovani

Druha ¢ast procesu tvareni.
Process 2 Insert Process 2>  Upsetting > Hot 3D FV A
4 Samul alion
Nazev 2 Etap?2 plail .
S0 el el eobver
= FE LoN o)
+ Geometrie
Model >  From File > Etap2 MG, Etap2 MD
Model >  From result > Etapl 100 %
e Ustaveni nastroju a polotovaru
e Obratime WP 0 90° okolo osy Y
e Vypneme UpperDie
¥ P& Trocesses =i
[ .
Piesuneme WP po ose Z nad MD E % Hocsarie —
v ; +-z Erapl [ AISI_1D15({T=800-1 ...
e Gravitani ustavime WP --Be {5 gmm e
=B+ PrasaHydr y
. , i (PEtapi_MD
e Zapneme UpperDie a ustavime tak, - %”:ED'EE e (P Chindizenie_wsad
, L owr e ape_f
aby se dotykal horni ¢asti WP mi4 r"r:;'f“*’d’
- Lowf[)i:mms Wiz
(P Etapz_Mo ngces
= mid Chlodzenic
4+ Parametry materialu, tfeni a teploty il Proces @Phtforma
=l WarkPlece @CHLODZENIE_WORKPIE...
, ., . R ETARL_WORKPIECE_1415 [(#Etapz_MD
Pro definovani materidlu, teni a teploty G DD.AISL_1015(T=3001200C) | | (PErapz 1
~vr s v r Tizoo
vyuZivame parametry s piedchoziho procesu. ﬁhimt Teperahire @Perees worsrIece _i41s
Forming

+ Definice bodl

Nadefinujeme body na vnitinich vodorovnych

povrsich néstroji.

Ptifadime prvky ke stromu procesu.

+ Definice zbyvajicich parametri procesu

Forming -  Stroke -

Vybrat nadefinované body a jako konecnou

vzdalenost mezi nimi zadat 56 mm.

Forming -  Element Size > 10 a 10 mm

Frcke:

Hlesvent Sees

Dukpk Crvisions:

Ot Pesuks

Scheer Cptimzs

=+ fujvarce d

Sober
RET/HOM
contat
Step cark el
Miscellansous

Direclion

Presa's paint

Diie’s paim:
Pz - F1 x|

Iiial chtanca i 2 EEETIET] o
Distoree o 100 skoke | o fa

24 AMEEE I
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Kombinace procesi

4+ Ovéfeni spravnosti zadanych tdaju

Check data > OK

4+ Spusténi simulace procesu

RUN

Pirocass Praperiies

7.4 Ctvrta etapa — zapustkové kovani

Tieti ¢ast procesu tvaieni — zapustkové kovani. S
Process = Insert Process 2 Closed Die > Hot 3D FV s;:; ’ =
Nazev 2 Etap3 Su:ﬁedmmrt ’

R R
+ Geometrie
Model > From File > Etap3 MG, Etap3 MD

Model >  From result > Etap2 100 %

e Ustaveni nastrojii a polotovaru
e Vypneme UpperDie
e Obratime WP o0 90° okolo osy X a nasledné o 90° okolo osy Z

e Piesuneme WP podél osy Z nad MD (Zkontrolujeme ustaveni pomoci ,,View
angles” a upravime rucn¢)

e (Qravitaéné ustavime WP

e Zapneme UpperDie a ustavime tak aby se dotykal horni ¢asti WP

E] Processas H &
) +-By Chlodz=nis Narme
+ Parametry materialu, tfeni a teploty +-By Eran] GPOB.ALSL_L035(T=000-1,.,
2 E [PEtapi_ma
/4 4 7 A 4 = Cap3
Pro definovani materialu, tfeni a teploty nE (Pexap: Mo
o 3 ’, E? Pﬁaihf;:je [Pchindzenis_twead
vyuzivame parametry s predchoziho procesu. g G"EWB - P Frasatiyd
not EEm0g
) proces #1200
= i LowsrDis Wrroces
Chlodz=niz
. . @ Etaps Mo o
% Definice bodli = o4 (drtatrorna
oif Pracas 3 CHLODZENIE_'WCREPIE. |
. ey =i WorkPisce [PEtapz_MD
Nadeﬁnu_]eme bOdy na vnitfnich §3 ETAPZ_WICRKPIECE_7Z01 [PEtapz MG
, “r ; ‘o 7 DELALSL_1015(T-200-1200C) | |E#ETAPL WORKFIECE 1413
vodorovnych povrSich néstroja. o 1200 Pt e
.Drrll:l_entTaTcE'aU.lre [PEtapi_MD
Farming B erarz_wORKFIECE 7201

Ptifadime prvky do stromu procesu.
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Kombinace procesi

4+ Definice zbyvajicich parametrii procesu
Forming >  Stroke >

Vybrat nadefinované body a jako kone¢nou vzdalenost mezi nimi zadat 13.5 mm.

W] Forming Camtrol {FV)

[ Zrckn

Forming - Element Sizes > 10 a 10 mm M oo Eemer e 11 m
oV vov. » , . .. O P REs U D Elarnari Sca ] ,mi o
(miuZeme zvétsit presnost vypoctu a prodlouZit b cpermae
L. . B . = Ko MoconbnciDinsr |2 VWP s
jejich cas pomoci redukce rozmeru prvku na 3+4 i N —————
I’}’li’l’l) e {711 22t b 2ov, ths ek hece el siem vl ued
Mezorlanzos

ks Forming Comtrol [F¥)

L. o, & Adean ¥ Falli:
Na zalozce Output Results ozna¢ime -t i
RET o
Contact ™ Lieveer
FOld/Lap m:\:ﬁ [ [ea e en
Muinn dercn o bade [0 ™

%+ Ovéieni spravnosti zadanych tdaji

Check data > OK

4+ Spusténi simulace procesu

RUN

O Shrnuti pojmu 7.1.

L Vl

Sestaveni modelu kombinujici vice procesu simulace tvafeni.
Procesy — chlazeni, péchovani materialu, zapustkové kovani
Definice bodi a senzori

Vyuziti menu ,,Cooling“ p¥i procesu chlazeni

E Otazky 7.1.

25. Lze v programu Simufact.forming 9.0 kombinovat vice procest?
26. Popiste cestu nadefinovani senzori na polotovaru?
27. Jaky typ Forgingu vybirame pfi zadédvani procesu zépustkového kovani — Hot/Cold?

28. Lze polotovar ustavovat gravitacn¢?
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Kombinace procesi

bl

®© NNk

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.

27.
28.

Kli¢ K reSeni

. Zapustkové a volné kovani (za studena i za tepla), Valcovani, Protlacovani,
Ohybani, Stiihani, Chlazeni, Vytlacovani

Heating

Definice materialu, Parametry vymeény tepla, Definice senzort, Definice tabulky
kontaktti, Sit’ konecnych prvki, Dalsi nastaveni procesu

Ano

Ofezavani, dérovani, vystiihovani, ostfihovani

Metoda FE, metoda FV

Moduly SIMesh tetra, Overlay Hex

StageControl ptidame tak, ze pravym tlac¢itkem mysi klikneme v okné stromu
procesu a vybereme ,,Insert StageControl”.

Upsetting

Metoda FE

4 varianty

Ano

Forwar Extrusion

Sheetmesh

Varianta s pouzitim pfidrzovace, varianta bez pouziti piidrzovace

Die type = Die spring & Manual

Ring Rolling

Ring Mesh

Press > Manual = Tabular Motion > Table type = Time/Velocity
Ano

Forward Extrusion

Ziskat ultra-jemné zrno materialu

FE — modul Overlay Hex

Intenzitu deformace

Ano

RMB = Insert Particles > Planes
Hot

Ano

Fakulta strojni, VSB-TU Ostrava
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